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Abstract
Saat ini banyak aplikasi di pasar yang digunakan untuk mengolah data baik itu data suara
maupun video. Salah satu aplikasi yang cukup populer saat ini adalah Adobe Audition
sebuah aplikasi yang diproduksi oleh sebuah perusahaan dengan nama Adobe Corporation.
Aplikasi ini dapat digunakan unfuk membuat sebuah data suara baik langsung dari
sumbemya yang direkam langsung maupun diambil dari sebuah sumber berupa CD musik
ataupun sebuah suara yang ada pada sebuah data video. Aplikasi ini juga memiliki efek-efek
suara untuk manipulasi suara yang biasanya dilakukan dengan menggunakan prosesor
suara secara piranti keras. Jumnal ini berisi tentang kelebihan dan kekurangan aplikasi
tersebut serta juga langkah-langkah yang dibutuhkan untuk melakukan pembuatan suara
serta manipulasi terhadap sebuah data suara.

Frieirirk

Introduction

Before digital technology is widely used, the analog technology was the best
common way to process any manipulation to sound or audio. Audio signal generated
by an instrument or any musical device is possible for manipulation. To get a new kind
of audio signal, it requires passing any filter that will process the audio to new form of
audio signal. Many effects may be added to an audio signal such as reverberation,
delay, chorus, flanging, compression, etc.

A device required to transform sound is called signal processor device. The
analogy to any altered sound is the same way as adding any spices in cooking or any
make-up in the theater. The important thing to consider is to have a good understanding
of the essential characteristics of the audio signal and what a signal processor can do to
it. To process the audio signal while using a lot of instruments or devices is not economic.
Having two forms of new audio signal may need at least two devices while processing
the signal.
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’ 4{ One of the software for the audio process manipulation is Adobe Audition, formerly

iy dit. It offers many features to manipulate an audio signal. There is no need to buy
&7 signal processor device to manipulate a sound instead of just using this software,
which can be installed in a Personal Computer (PC). The version of Adobe Audition
used in this journal is Adobe Audition 1.5.

Brief History of Adobe Audition

A company called Syntrillium released audio software before year 2000 called
Cool Edit 2000 and Cool Edit Pro; Figure 1 shows the logo of the software. They were
successful audio software in the market. In May 2003, another big company, Adobe
Corporation, bought the Syntrillium and altered the name of the software to Adobe Audition
with its first version, version 1.0. Figure 2 shows the new logo of the Adobe Audition
software.

Figure 1. Logo of the Syntfrillium software

A

Figure 2. New logo of the software

Things to Make Sure Before Starting

A PC commonly is equipped with an audio card in order to process any audio
data either to have it as an output or converted to another audio variation. To start audio
manipulation in a PC the important things to ensure is this audio card is plugged already
and detected by the Operating System (OS) used for the PC. The minimum requirements
for the system are Intel® Pentium® [l or 4 or Intel Centrino™ processor, Microsoft®
Windows® XP Professional or Home Edition with Service Pack 2, 512MB of RAM (1GB
recommended), 1,024x768 display (1,280x1,024 recommended), Sound card with
DirectSound, DVD-ROM drive, CD-RW drive for audio CD creation, and Speakers or
headphones [3].
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The minimum specs mentioned above are things to make sure before starting
audio process. A PC may have more than one audio card. Adobe Audition supports
selection of any available audio card plugged to the computer. This may be done by
setting the device used for manipulating the audio. The source of the audio may be
directly from any instrument or device connected to the audio card either through the
line-in or microphone. The larger the size of the memory used the quicker the application
processes any given task instead of just the minimum memory size.

Benefit of Using the Application

Multimedia is the seamless integration of text, sound, images of all kinds and
control software within a single digital information environment [2]. This application is
classified as a multimedia application because it is involved in processing combination
of the sound and video and the moving pictures or images. Before changing its name to
adobe audition, it can only deal with the task of audio but in this new face, it integrates
with popular audio technology such as ReWire and Virtual Studio Technology (VST) [4]
and video applications like Adobe Premiere Pro and Adobe After Effects.

Adobe Audition supports up to 32-bit files and sample rates up to 10 MHz as
long as it is equipped with 32-bit internal processing, Its other feature such as powerful
effects, restoration, and pitch correction tools enhanced the new audio. It also puts all
the tools needed to get work done quickly and efficiently. An intuitive interface shorten
the processing time such as editing, mixing, and streamlining the audio workflow through
CD burning. Even though integration of audio and video exists in this application, it is
mainly focused on the audio.

In early technology to manipulate the audio as a part of multimedia component,
tape had important role in the nature of the multimedia systems. New form of multimedia
emerges when the media moves from the outside of the computer to inside. There
were two major changes, which are digitization of the media and the drastic price reduction
of digital storage systems [2].

Inside the application the necessity of usage of manual devices or components
in minimized. All tasks done by it involve digital process. It requires no external device
for adding any effect to the audio, all fully digital.

inside the Adobe Audition

To run the application click on the link to the program located in Start-All Programs
as seen in figure 3.
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Figure 3. The link to run the application

Once it is opened the main working area is displayed. It is divided into three main
work areas: Edit View, Multitrack View, and CD Project View. This intended to help
focusing on the major tasks of editing audio files, mixing sessions, and burning CDs.
Figure 4 shows the main working area.

All three views have a similar user interface, including the following components:
Menus, Toolbars, Windows, and Display Window. Before starting any project, setting up
the application is the first to do to ensure the good audio output. The setup tasks can be
divided into some categories, which are setting up the devices being used, customizing
internal preferences, and managing the size of temporary files. Computer may have
multiple sound cards, or a single card that has multiple inputs and outputs. To get the
right component in the right track devices need to be specified either for purpose of
playback or recording. It also may need setting up other device such as MIDI devices,
external controllers, and ReWire connections.

Figure 4.
Application Working Area A. Edit View tab B.
Multitrack View tab C. CD Project View tab D. menus
E. toolbars F. display window G. various windows
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The size of temporary files is limited only by the amount of disk space that is
available. it is recommended to have a dedicated amount of space in the hard disk
separated from the main hard disk used for the main task of operating systems. However,
shall any problems emerge while working with very large files (or when you have many
files open at the same time) for example running the disk space low, deleting the unused
files will be the solution.

There are wide range of devices may be used with Adobe Audition. Sound card
inputs bring audio signals into Adobe Audition through sources such as microphones,
tape decks, and digital effects units. They also monitor audio signals through sources
such as speakers and headphones. MID! ports connect Adobe Audition to MIDI
keyboards and synthesizers. You can also synchronize Adobe Audition with ReWire
applications and hardware or software components that support Society of Motion Picture
and Television Engineers (SMPTE) [5] / MIDI Time Code (MTC) time code.

To designate the devices the Device Order dialog box is used. When working in
Edit View, one stereo output device can designate to use for playback and one stereo
input device for recording. When working in Multitrack View, different input and output
devices can be assigned to each audio track. If audio system includes MIDI devices,
they can also be designated for MIDI input and output devices to use. For example, a
MiIDI keyboard can be designated to use for triggering commands and a MIDI synthesizer
channel for playback.

Steps to designate the devices to use are choosing Options > Device Order,
click the tab for the type of device to designate: Playback, Recording, MIDi Output, or
MIDI Input. Move the devices to use into the Multitrack Device Preference Order list by
selecting devices in the unused list and clicking Use. Remove unwanted the devices
by selecting devices in the Multitrack Device Preference Order list and clicking Remove.
This application may support up to 16 stereo devices or 32 mono devices in the Multitrack
Device Preference Order list. See figure 5.
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Figure 5. Menu to select the device(s)

Designate the device in Edit View by selecting the device and clicking Use in EV.
[EV] appears after the device name. Adjust the order of devices for use in Multitrack
View by selecting a device and clicking Move Up or Move Down. The first device in the
list is the default device. This means that, by default, the first playback device is assigned
as the output for all audio tracks in a session and the first recording device is assigned
as the input for all audio tracks. Likewise, the first MIDI Out device is assigned as the
output for all MIDI tracks. However, you can easily reassign the devices for a track. (See
Using the Track Properties window and Importing and mapping MIDI files.) If desired,
click a different tab to set up ordering for another type of device. Click OK to finish.

Playback Devices | Recording Devices | MIDI Output Devices | MIDI Input Devices |

Please choose which davice will be used in Edit View, and what devices you would ke to use in Muktitrack
View. The top Multitrack Device in the kst will be “Device 1", the second "Device 2" and <o on.

Unused Playback Devices Mukitrack Device Preference Order

Wave Mapper I 1st SR Live! Audio [DACD] [EV
<< Remove |

Figure 6. Device Order Window

Through Device Properties dialog box Adobe Audition’s parameters for playing
back waveforms is configured. The properties for each output either using multiple sound
cards or a single card that has multiple audio outputs is set in this dialog box. Steps to
set are choosing Options, Device Properties, click the Wave Out tab and selecting a
device from the list at the top of the dialog box.
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Figure 7. Device Properties Window

The capabilities of the selected output device are shown in the Supported Formats
table. Shown in table 1. A Yes or No indicates different combinations of sample rate and
bit resolution. This table also shows what (if any) 32-bit formats the output device can
handle, and whether it can accept the WDM driver extensible wave format.

8-bit 16-bit
Rate Mono Stereo Mono  Stereo
8K Yes Yes Yes Yes
11K  Yes Yes Yes Yes
16K Yes Yes Yes Yes
22K  Yes Yes Yes Yes
32K Yes Yes Yes Yes
44K Yes Yes Yes Yes
48K Yes Yes Yes Yes
96K Yes Yes Yes Yes
24-bit (3-byte packed) supported
32-bit (4-byte PCM) supported
32-bit (IEEE Float) supported
WDM “Extensible’ Supported

Table 1. Supported Formats
Order displays the order of the device for use in Multitrack View. To change the order of

the devices click change button. The application will use the device to play waveforms
in Edit View if the option in figure 6 is ticked.

[V Use this device in Edk View

Figure 8. Option to display device in Edit View
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g | The option limit the playback (see figure 9) is used to compensate for limitations
sed by hardware. For example, if the sound card desn not handle 32-bit audio
correctly, use this to limit the playback of 32-bit files to either 16-bit or 8-bit. The option
Send 32-bit Audio As specifies how Adobe Audition sends 32-bit audio data to the
output device. (See figure 9) This option is unavailable when selecting a Limit Playback
To option. If the output device supports it, sending 32-bit audio as 3-byte Packed PCM,
4-byte PCM, or 4-byte |IEEE float is possible to do.

Limit Playback to: Send 32-bit audio as:
[T 8-bit (Edk View only) " 3-byte Packed PCM
[T 16-bit & 4-byte PCM
™ Mono (Edit View only) " 4-byte IEEE float
[T Try as WOM

Figure 9. Options to suit the hardware

Enabling Dithering activates dithering when playing back audio at a limited bit
depth. See figure 10a. Deselecting this option will truncates the audio data instead. This
means that bits that aren't used are simply chopped off and discarded. Enabling dithering
is recommended when working with audio files that have a higher bit depth than sound
card supports. Its options are available when dithering is enabled. Maximum bits to
specifies the number of bits to dither to is 32. If using a 20-bit sound card, for example,
and requiring dithering to 20 bits since any more bits will not be used by the card. Even
for 16-bit-only sound cards, choosing to dither to 16-bit will improve the quality when
playing back 32-bit audio. probability distribution function (p.d.f) (figure 10b) controls
how the dithered noise is distributed away from the original audio sample value. Usually
one of the Triangular p.d.f. Functions is a wise choice, because it gives the best trade
off between Signal-to-Noise Ratio (SNR) , distortion, and noise modulation. Shaping
specifies a noise-shaping curve for moving noise to different frequencies (figure 10c).
To obtain no shaping just choose no noise shaping from the available options.

Figure 10. a. Bit Dithering b. p.d.f options ¢. Shapping
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Starting a Project

To start a new project, choose the menu File and New Sesssion ( see figure 11)
or simple press Ctrl+N on the keyboard.

Append to Session. .,
Figure 11. Starting a new project

The window for sample rate option will display (figure 12). Sample Rate determines how
many frequencies can be encoded in the audio signal. Higher sampling rates mean
wider bandwidth.

New Waveform _)2
;Sampie Rate —; - Channels~ -1 rRetolution -~ -

W— CHoo | opbr

% Stereo @ 16tk
{16 32.b (foat)

_Cancd |
bt |

Figure 12. Sample rate of the audio

During the sampling process, an incoming analog signal is sampled at discrete time
intervals. Each interval of analog signal is momentarily observed, and thus, each
represents a specific, measurable voltage level. A mathematical conversion generates
a digital series of numbers that represent the signal level at that particular point in time.
The generated data can be digitally stored or processed.

The sample rate is the number of samples (or snapshots) that are taken of an
audio signal per second. For example, a sample rate of 44,100 Hz means that 44,100
samples are taken per second. Since sampling is tied directly to the component of
time, a system’s sample rate determines a system'’s overall bandwidth—in other words,
how many frequencies can be encoded within the audio signal. Higher sample rates
generally yield a better quality waveform. The most common sample rates for digital
audio editing are as follows:
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11,025 Hz Poor AM Radio Quality/Speech (fow-end multimedia)
22,050 Hz Near FM Radio Quality (high-end multimedia)
32,000 Hz Better than FM Radio Quality (standard broadcast rate)
44,100 Hz CD Quality
48,000 Hz DAT Quality

e 96,000 Hz DVD Quality
To create output that can be played using a common CD player choose the CD
Quality sample rate which is 44,1KHz.

Channels (figure 10) determine if the waveform is mono or stereo. Select Mono to create
a waveform with just one channel of audio information. This option works well for a voice-
only recording. Select Stereo to create a two-channel waveform with separate right and
left channels. This option is usually best for a music recording because they contain
twice as much data; stereo waveforms consume twice the storage space of mono
waveforms.

Resolution (figure 10) determines the number of unique amplitude levels Adobe
Audition can use to represent a sound. The 32-bit level is best while working in Adobe
Audition, and you convert down for output if necessary. Older sound cards might not be
able to play 32-bit files properly. To check the capabilities of sound card, choose Options
> Device Properties. If sound card doesn't support 32-bit files, convert the files to a
lower bit rate {such as 16-bit) for playback.

Some options are avaitable to open files in Edit View (see figure 13).

Sl Edit  View Effects ¢
Open As..,
Open Audio from Video. ..
Extract Audio from CD...

Figure 13. Open File Options

To create a new audio file, choose the menu File and New, if the audio file exists already
previously the other options may be chosen. Recording audio can be done from a
microphone or any signal plugged into the Line In port of a sound card. Adjustment of
the input signal is important to obtain the optimum recording and signal-to-noise levels.

Adobe Audition doesn't directly control a sound card’s record levels (input gain)

and playback leveis (output volume). Adjusting levels is necessary if recordings are too
quiet (causing unwanted noise), too loud (leading to clipped, distorted sound), or not
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[ble when played in Adobe Audition. Just open the Audio Control for Windows (as
in figure 14)

Play Contrel Wave/MP3 PC Speaker Awdiary Microphoae Linein CD Audio
Balance: Balance: Balance: Balance: Balance: Balance: Balance:
O e 4 J- 8@ S~ &9 3 9
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Figure 14. Windows Audio Control

By default, Adobe Audition displays waveforms in real time while recording. However, if
the recorded audio is choppy, deselect Live Update During Recording in the General
tab of the Settings dialog box. Once the source of the audio is plugged to either the
microphong or line-in port of the sound card, the recording process can be done by
clicking the record button (figure 15), button with red dot. To stop recording is simply by
clicking the stop button, button with green square in the middle.

S

Figure 15. Operation Button

The recorded signal is will be displayed directly after clicking the stop button or the
record button as seen in figure 16.

NSO ——— -
P B e e e, TS

Figure 16. The recorded audio signal
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{idio is recorded then only one graphic is dislayed. Figure 17 shows a bad example of
the recorded audio. The level of the source is too high so the adjustment of the source
is needed.

Figure 17. Bad Audio Source Level

Once the recording phase is finished, the data can be save to the default format of audio
standard used by Windows, WAV. To save data to a file select the File and Save AS
menu as seen in figure 18.

Figure 18. Save the Audio Data

Next window will appear to give option where the file need to save to (figure 19). Select
the place to save the file in the option Save In. Right side of the window shows available
free space of each storage attached to the computer, and the default format of the audio
file is WAV. Click the Save Button to finish the saving process. Once the audio file exists
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Figure 19. Save As Windows

Converting Audio

The Audio can be converted either by its sample rate or the end format of the
audio file and it is also possible to convert the audio to its reverse version. A file's
sample type determines its sample rate and bit depth, as well as the channel format
(whether the waveform is mono or stereo). Converting the sample type to change any of
these attributes is possible. When converting the sample type of a file, Adobe Audition
directly processes the samples within the file, or resamples the data, so that the audio
retains the same pitch and duration as the original file.

Adjust Sample Rate...

Convert Sample Type... Fi1

Figure 20. Menu to convert the audio

To convert an audio or a current processed audio file, find the menu at the bottom of the
Edit Menu. To only adjust the sample rate select Adjust Sample Rate, but for the converting
the sample including its channel, resolution and dithering feature, select the lowest

menu of the Edit Menu.
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Converting the format of the audio is also possible to meet any requirement. For
example, to put the audio file for a website, the WAV format is absolutely is not the
option to choose. The available bandwidth of data to transfer data across the network
especially internet is the limitation to choose the format. Many other platforms are also
available such as Macintosh and Unix environment. They also use different for of the
audio. To accommodate this, the conversion is a must. The most popular audio type
used by most people is MPEG Audio Layer 3 (MP3) format. MP 3, more commonly
referred to as MP3, is a popular digital audio encoding and lossy compression format
invented and standardized in 1991 by a team of engineers working in the framework of
the ISO/IEC MPEG audio committee under the chairmanship of Professor Hans Musmann
(University of Hannover, Germany). It was designed to greatly reduce the amount of data
required to represent audio, yet still sound like a faithful reproduction of the original
uncompressed audio to most listeners. In popular usage, MP3 also refers to files of
sound or music recordings stored in the MP3 format on computers. [6].

MP3 is a lossy format; it is able to provide a number of different options for its “bit
rate”—that is, the number of bits of encoded data that are used to represent each second
of audio. Typically rates chosen are between 128 and 256 kilobit per second. By contrast,
uncompressed audio as stored on a compact disc has a bit rate of about 1400 kbit/s.
MP3 files encoded with a lower bit rate will generally play back at a lower quality. With
too low a bit rate, “compression artifacts” (i.e., sounds that were not present in the
original recording) may appear in the reproduction. A good demonstration of compression
arlifacts is provided by the sound of applause: it is hard to compress because it is
random, therefore the failings of the encoder are more obvious, and are audible as
ringing.

Manipulating Audio

Sometimes it is not enough to have just the original audio recording. A new
recording needs impact or perhaps clean up. There are several type of audio
enhancement and restoration effects. Noise reduction effects remove unwanted hiss,
hum, clicks, or pops. Filter effects that let you change overall tonal balance, from rumbling
bass tones to sparkling highs. Amplitude effects precisely control audio volume for
increased radio impact, detailed fade outs, and more. All of these effects are available
in Edit View, but some don't exist in Multitrack View because the two views are linked,
however, this limitation can be easily overcomed . If a multitrack clip requires noise
reduction, for example, simply double-clicking the clip will process it in Edit View.
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Mastering describes the complete process of restoring and enhancing audio files
for a particular medium, such as radio, video, CD, or the Web. In Adobe Audition,
mastering is either individual audio files in Edit View or groups of files in a batch process.
(Batch processing is particularly useful for buming a group of files to CD.

The mastering process consists of several stages, which are usually performed
in the following order : Analysis, Noise reduction, Equalization, Compression, and
Normalization To ensure that the loudest sounds reach the highest possible level that
digital systems allow—0 dBFS. Reversing the order of the equalization is also possible.
In Edit View, the frequency, phase, and dynamic range of an audio file can be analyzed.
These analysis options are particularly helpful when used in conjunction with the many
enhancement and restoration effects in Adobe Audition. For example, the Frequency
Analysis window can be used {o identify probiematic frequency bands, and then correct
them with a filter effect. Similarly, Waveform Statistics dialog box can be used to determine
dynamic range and then compress it with an amplitude effect.

Adobe Audition contains a wide variety of effects for changing stereo imagery, adjusting
pitch, and adding delay (for example, reverb and echo). Dialog boxes for these effects
share many common options, such as graphs, spline curves, presets, and previews.
Effects provide much of the functionality in Adobe Audition. For example, the use of effects
to remove noise, optimize volume, change pitch, and add reverb. If Adobe Audition doesn't
provide the effect required, it is also possible to purchase a plug-in effect to do the job.
Adobe Audition can change the apparent location, or stereo imagery, of sounds coming
from the speakers. For instance, moving a sound from the center to the left or right speaker
or even make sounds seem to circle a listener's head. Note that all of the stereo imagery
effects except the Doppler Shifter effect work only on stereo files.

Chorus, flanger, and phaser effects can thicken sound or make it outrageous.
They range from the Chorus effect’s ability to make a single instrument or vocalist sound
like a group playing or singing in unison, to the wilder sounds of the Flanger effect and
the phaser effects. They can be applied not only in stereo for the most dimensional
resuits, but also mono sound as well. The Chorus effect adds richness as if several
voices or instruments are played at once. It's a great way to add a degree of presence
to a track. It can be used to give a stereo effect to a mono sample (where the left and
right channels are identical) or to add harmony or “thickness” to a vocal track. It also can
be used to create some truly out-of-this-world special effects. Adobe Audition uses a
direct-simulation method of achieving a chorus effect, meaning that each voice (or layer)
is made to sound distinct from the original by slightly varying the timing, intonation, and
vibrato. The Feedback setting add extra detail to the result.
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Flanging was originally achieved by sending an audio signal fo two reel-to-reel
tape recorders and then physically slowing down the reels of one machine. The resulting
sound has a phase-shifted, time-delay effect, characteristic of psychedelic recordings
of the 1960s and 1970s. The Flanger dialog box creates a similar result by slightly
delaying and phasing a signal at predetermined or random intervals.

Similar {o flanging, phasing introduces a variable phase-shift to a split signal and
recombines it, creating psychedelic effects first popularized by guitarists of the 1960s.
The Sweeping Phaser effect sweeps a notch- or boost-type filter back and forth about a
center frequency. A phase is similar to a flange except that instead of using a simple
delay, frequencies are phase-shifted over time. If a phase is used on stereo files, the
stereo image can be dramatically altered to create some remarkably interesting sounds.

Conclusion

Adobe audition provides intuitive interface for the user to create or modify audio
file. It offers variety of effects to complement either any audio that exist previously or that
has been created newly. To create an audio file is easy task by this application. Audio
conversion and manipulation is not a hard task any more because adobe audition
provides ease of use to the user who needs another format of audio files or perhaps
enhanced audio files for many purpose.
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